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Foreword

Thank you for purchasing the POWERCERT Power and Energy Meter.

This manual explains how to set up the POWERCERT PC Parameter Setting Tool and
use it basically on Windows 2000 and Windows XP. Please read this manual carefully
before operating the PC Parameter Setting Tool to ensure its correct use.

After you have read this manual, keep it in a safe place where it can be referred to
anytime a question arises.

For specifications and operations of the product, refer to the user’s manual provided with
the product.

This manual does not explain the basic operations of operating system. For the basic
operations of the operating system, read the user’s guide of Windows.

Notes
 The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the performance and functions.

* Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer.

» Copying or reproducing all or any part of the contests of this manual without the
permission of Yokogawa Electric Corporation is strictly prohibited.

« Yokogawa Electric Corporation shall not be held responsible by any party for any
losses or damage, direct or indirect, caused by the use or any unpredictable defect
of the product.

Copyright

Yokogawa Electric Corporation holds the copyright to the software.

Trademarks
« All the brands or names of Yokogawa Electric’s products used in this manual are
either trademarks or registered trademarks of Yokogawa Electric Corporation.

 Microsoft and Windows are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

» Adobe and Adobe Acrobat are trademarks of Adobe Systems Incorporated (Adobe
Systems).

« Ethernet is a registered trademark of XEROX Corporation in the United States.

» Other company names and product names used in this manual are either registered
trademarks or trademarks of their respective holders.

Revisions
1st Edition May 2006

1st Edition: May 2006 (YK)
All Rights Reserved, Copyright © 2006 Yokogawa Electric Corporation
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1. Before Using the Software

1.1 Overview of the Configuration Software

The POWERCERT PC Parameter Setting Tool is the software having the following
functions.

Function

» Send and receive the parameter settings.

« Set the display pattern (for the PR300 only).
« Set and reset the energy value online.

* Save the setup data to a file.

« Edit the setup data.

* Print the setup data.

Flow of Operation

The flow of operation of the software is shown below.

To change the settings of the

power and energy meter To change a setup data file

Connecting the power and energy
meter and the PC

(Section 1.4)

Starting the software

% (Section 2.1)

Setting the communication mode

(Section 2.2)

Receiving the setup data of the
power and energy meter

(Section 2.3) (Section 2.3

Changing the settings

(Section 2.3

Sending setup data to the power
and energy meter

(Section 2.4) (Section 2.5)

Opening a setup data file

~

~

Saving the setup data

Figurel.l  Flow of Operation
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1.2 PC System Requirements

Tablel.1 PC System Requirements

PC

IBM PC/AT compatible model (DOS/V PC)

(ON]

Windows 2000 Professional (English version) (Service Pack 2 or later)

Windows XP Professional (English version) (Service Pack 2 or later)

CPU

800-MHz Pentium Il or higher recommended.

Memory

256 MB or more

Hard Disk

Free disk space of 10 MB or more.

Communication
Port

An RS-232 port (for Modbus/RTU) or an Ethernet port (for Modbus/TCP)
supported by the OS.

For communication connection by Modbus/RTU (RS-485), use the RS-232/RS-
485 communication converter.

Yokogawa's ML2 RS-232C/RS-485 converter recommended.

Display

A display supported by the OS with 800 x 600 resolution and 32000 colors or
better.

1024 x 768 resolution and 65536 colors recommended.

Printer

A printer supported by the OS. An appropriate printer driver for the OS is also
required.

Others

A mouse connectable to a PC and supported by the OS.
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1.3 Installing the Software

Switch on a PC. Start Windows. Log onto Windows as an administrator.
Exit memory resident programs such as virus protection programs before installation.

When reinstalling the software, uninstall it first. Double-click “Add/Remove Programs”
in the Control Panel and uninstall the software. As necessary, back up the setup data
files with .P3D and .U1D extension.

Download the Setup File from the following URL.
http://www.yokogawa.com/ns/pr300/download/

After downloading, decompress the File and follow the following steps for setup.
Please execute the setup by the shallow directory. (ex. C:\Powercert\ )

Stepl Double-click Setup.exe.

Powercert PC parameter setting tool Setup iz preparing

g the InstallShield(r] \Wizard which will guide you through
= the rest of the setup process. Please wait.

.

Step2 To start the installation process, click Next. To cancel starting the
installation process, click Cancel.

Welcome %]

ahcoina 1o s Povstocart PC patasates tafing tocl Sathup
program. This pengeam vl insial Prssescent PC porameins seliing
Rl 01 v e

I B siTrngly rennemended Bl e el wWindnee: pngems
before runrang this Sebup peogram.

Lk Cancel 1o quit Satup &red then chocs Sy poograns pou hisvs
mrring Click Mest o continue with fhe Setup progras

WARMENG: Thes poogram m peobeched by coprpeghl ey and
ndemnational mester.

Ulnsuterized reproduction o digtabution of this pooagram, of &
gntn ol d, oy el w o cral ] el el
wll ot prgacuiad B0 thed S éxdind Do pible undes b,

et > Corcel |

Step3 Type your name and the company name you work for. Click Next.

Lhser Information

T yonn rusives Besbowy, Woa st Bloo type Bhe raes of the
O oLl v for

M |i-"mla||

Compary:  [YORDCAWA

+ Back Mot Carcel
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Clowsae Deeslination Localion

Selup vall wislall Foweicel T pasieber sethng ool lhe
fnllowving dincinegy.

To irstall by this dmciney, choi Mt

To rrtall bo & dlererd desclony, chck Beorme and select srolbe
danciney.

i Gan choose nol 1o retsll Possiced FU paiasele sellrg ool
Iy cliching Canced b el Sehup

[Drreatiation Diavcing
e'\pengenm flea' Posnacest Eimroa..
cBack | Medy | Com |

Powercert. Click Next to start the installation process.

Seelen! Program Eoldier

Do vall Sckd program wons Lo ke Piogeass Folder keled beloa.
''ous mag ippe: 2 new foldes nome, o select ore from dhe eststing
Foldeis st Chick Mext 10 continie,

Frogeam Foldess,

cBack | Mets | cawe |

Selup Comprlete

Selup b e wmslalng the appbcabon on you compde:,
Yicaa vty lsunch the: sppbc stion by telectng the cont mstaled.

Chck Finigh 1o complate S stup,

Fresh

Step6 Click Finish to complete the installation process.

Step4 Confirm the directory to be installed, then click Next. To install to a
different directory, click Browse and select another directory to be
installed.

Step5 Set up a folder name of the program icon. The initial value is

IM 77C01Y01-01E
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1.4 Connecting the Power and Energy Meter and
the PC

The following three methods are available for connecting the power and energy meter
and the PC.

Serial Communication Connection

Approx. 1200 m maximum (31 units maximum)

vy
v

PR300
UPM100
UPM101

PR300
UPM100
UPM101

PR300
UPM100

UPM101
*3

RS-232C
straight Converter
(Yokogawa)

120 (built-in)

Short circuit

(A) (B4) (SG) RS-485 \[TERM) (A (éﬂ (SG)

RS-485

Terminator
T~ T~ T T N o
(FG) =

*1 120 Q externally connected (parts no.: L3035RK)

Use the resistor externally connected without using the built-in resistor of ML2.

Make resistance of the terminator the same as that of the resistor.
*2 When connecting the ML2, use it without returning an echo. Set the communication

For details, refer to the ML2 RS232-C/RS-485 Converter User’s Manual (IM 77J04L02-01E). method of PR300,
*3 For the UPM100 and UPM101, 120 Q resistors are not built in. UPM100 and UPM101

to Modbus/RTU.

Notes:

The PR300 employs a two-wire system for RS-485 communication.

SG: The SG terminal is connected to match the signal level of the RS-485 communication line.

FG: All shielded wires must be connected and then grounded at one place to provide noise protection for
RS-485 communication lines.

Figurel.2  Example of Serial Communication Connection

Ethernet Communication Connection (for the PR300 Only)

PC
IP address: 192.168.1.1

Ethernet

IP address: 192.168.1.2 IP address: 192.168.1.3
Figurel.3  Example of Ethernet Communication Connection

IM 77C01Y01-01E  1st Edition : May.26,2006-00
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Connection Using Ethernet-serial Gateway Function (for the PR300 Only)

Higher-level device
” |P address: 192.168.1.1 (arbitrary)

Ethernet

10BASE-T/100BASE-TX

PR300 (with Ethernet communication .
function) or VJET Ethernet-RS485
Converter

Station number 01 (fixed)
IP address: 192.168.1.2
(arbitrary)

CREnE. ™., ==

l”.J.:l'Ll_lﬂn'
EE@EIB

i
kit

Station number 10
(arbitrary)

Station number 02
(arbitrary)

Figurel.4  Example of Connection Using Ethernet-serial Gateway Function

For details of connection, refer to the user’s manual of each product.

About the connection to
the UPM100

UPM100 Power Monitor User’'s Manual <Installation>: IM 77C01H01-01E
Communication connection in Chapter 4, “External Wiring”

About the connection to UPM101 Power Monitor User’s Manual <Installation>:

the UPM101

IM 77C01J01-01E

Communication connection in Chapter 4, “External Wiring”

About the connection to PR300 Power and Energy Meter Startup Manual

the PR300

<Installation>: IM

77C01E01-02E Communication connection in Section 2.6, “Other Wiring”

or PR300 Power and Energy Meter User's Manual: IM 77C01EO01-01E
Communication connection in “Other Wiring” in Section 1.3, “Wiring”

The terminal numbers for communication of each product are as follows

IVIOd(:)l'l'erminal symbol AQ) B(+) sG
ML2 3 4 5
PR300 18 19 20
UPM100/UPM101 10 9 8

IM 77C01Y01-01E
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2. Configuring the Power and Energy Meter

2.1 Starting/Closing the Software and Showing
Version Information

Starting the Software

From the task bar, click Start, point to All programs > Powercert, and choose PC
parameter setting tool. The software starts.

" Prwurcert PC paramater selliog lool - [HewFike]

Fle Commiation Seltfg Yew Hop

—_— Menu bar
DEd & & % T —

Toolbar

¥ Urieprind Thvws-ghasce Jowirs @4 Urierpal Thess-phass dovwve @ Thesephars domirs (35 simant
g obagengad Curent
11 Liribver pind ioibage Ingady) S0, 00, BOVHIA AC 1@ 3 Lirivverpind Viokage Ingua{] S0, 00, BOOVHEA AC > Machine information
Aol Igad i vl Furction L
0 1 Dot 2 1 gl s, | Pl Uk (for indication only)
@1 1 g g, 1 A Cutied 100 8 DN g, 1 Anaiog Cutpul, 1 Pl Oulped
Commurication Function T It P40 Communication @ T RE-A0S Communication, [iheme ©
phional Messparing Furetion S b Mone B Demand Mesprement (1 Demand Alws Sutpat)
[Pirowen Sagply G DO ACTe O] [SMCHE), 1 30200 DR 1SR
ez P mhaes it R R, S e T et s B e © e J
pnd Parareden s
Trans mst e Saslom
@ Srge-phase 2vre @ Sngle prase 3wre L Treee prase 3-wie Input parameters (for
et the PR300 only)
@ iasac S TV AL @ astrin s AL : FERrm I

Figure2.1  Model and Suffix Codes Screen (Example Screen of the PR300)

Closing the Software

From the File menu, choose Exit, or click the X button.
The configuration software window closes.

Showing Version Information

From the Help menu, choose About. You can also click the About icon ( ‘@ ) on the
toolbar. The About dialog box opens.

Powercernt PC parameter zetting toal R1.01

Copyright [C] 2006 *'okogawa Electric Corporation

Software Japan

Figure2.2  Version Information

Click OK to close the About dialog box.

IM 77C01Y01-01E  1st Edition : May.26,2006-00
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2.2 Setting the Communication Mode for
Connecting to the Power and Energy Meter

Modbus/RTU (serial communication) and Modbus/TCP (Ethernet communication) are
available as communication mode.

1. From the Communication menu, choose Communication Setting. You can also
click the Communication Setting icon on the toolbar. The Communication Setting
dialog box opens.

Ez Powercert PC parameter setting tool - [NewFile]

File  Communication tting View Help

DzE &S ?
h S

2. Select the communication mode. Set the communication setting according to the
device. To execute the automatic detect, set the items other than the station
number then click Automatic Detect.

Select
Modbus/TCP

Commundeation Satting

Commundeation Satting

: et When using

| j °"""" e Ethernet-fserla_l

. gateway function,
e e (ookes B Modbus/RTU I enter the station

number of serial
communication

] Ausnnane e\ Javice.

Figure2.3 Serial Communication Setting Screen  Figure2.4 Ethernet Communication Setting Screen

Automatic Detect:
1. Click Start Detection.

2. The connected devices are displayed.
Then click the No. of device to be set.

3. Click OK.

Figure2.5 Serial Communication Setting Screen

3. Click OK

The dialog box closes, and the communication between the PC and the power and
energy meter is enabled. Click Cancel to cancel the settings and close the dialog
box.

Note

After starting the software, be sure to confirm the communication settings and click OK. Then Receive
Setting, Send Setting, and Integral Energy of the Communication menu can be selected.

IM 77C01Y01-01E  1st Edition : May.26,2006-00
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2.3 Receiving the Setup Data or Creating New
Setup Data

The following three methods are available for starting to create setup data.
* Receive the setup data of the power and energy meter.
* Open a setup data file.
* Create new setup data.

Receiving the Setup Data of the Power and Energy Meter

Before carrying out the following procedure, check to see that the communication mode
and parameters are set correctly. For details, see Section 2.2, “Setting the
Communication Mode for Connecting to the Power and Energy Meter.”

1. From the Communication menu, choose Receive Setting. You can also click the
Receive Setting icon on the toolbar. A confirmation dialog box for receiving settings
opens.

£z Powercert PG parameter setting tool - [NewFile]

File Communication Setting  wiew Help

DEzE & &% pmt ?

2. Click OK.

The reception starts. When the reception of the settings is complete, a message
appears to indicate it.

Receive setting

! E Receive setting from connecting machine?
L]

oK | Cancel |

3. Click OK.

Receive setting

Ll
\lr) Finish receiving setting data

IM 77C01Y01-01E  1st Edition : May.26,2006-00



<2. Configuring the Power and Energy Meter> 2-4

4. The received setup data is displayed.

DS E @ sy ¥

Figure2.7 Parameter Setting Screen (Example Screen of the UPM100/UPM101)

IM 77C01Y01-01E  1st Edition : May.26,2006-00
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o Powercert T parameter sotting tool - [HewFile]
Fie Comearicstion Seiting Yew el
D@ H & & seL ¥

Dizpiay Fabiem Seting I

et Dispiy Paloen Setng |

oty
Figure2.8 Display Pattern Setting Screen (for the PR300 Only)

Opening a Setup Data File

1. From the File menu, choose Open. You can also click the Open icon on the tool
bar. The Open dialog box opens.

B2 Powercert PC parameter setting tool - [NewFile]

File Communication Setting Wiew Help

(EH & & v a2

2. Select the desired file, and click Open.
The setup data is displayed.

Open
Look in: I&} D ata j - rj( Ed~

PR3005ETOL.P3D

File name: | Open I
Files of type: IPHSDDsetting file: [ P3D] | Cancel |

Note
The extensions to setup data files are .P3D for the PR300 and .U1D for the UPM100/UPM101.

IM 77C01Y01-01E  1st Edition : May.26,2006-00
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Creating New Setup Data

1. From the File menu, choose New. You can also click the New icon on the toolbar.

= Powercert PC parameter setting tool - [NewFile]

File  Communication Setting Wiew Help

|@ﬁn|§|%|w¢.1|@

2. Set the machine information of the power and energy meter.
If the set machine information is not correct, the setup data cannot be sent correctly.

Fle Comrronicsbion Seiting Ve Help

O e & %L

Figure2.9 Model and Suffix Codes Screen (Example Screen of the PR300)

IM 77C01Y01-01E  1st Edition : May.26,2006-00
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2.4 Sending the Setup Data

The following four methods are available for sending the setup data.
« Send the input parameters (for the PR300 only).
» Send the parameter setting.

« Send the display pattern setting (for the PR300 only).
 Send collectively (input parameters, parameter setting, and display pattern setting)

Note

To send the setup data, set the communication and machine information correctly.

Sending the Input Parameters (for the PR300 Only)

Send only the input parameter data to the device.

1. Set the input parameters, and then click Send Input Parameters.
A confirmation dialog box for sending the setting opens.

" Powercert PC parsmeter seiting tool - [MewFiic]

Fle Commonecstion Seftrg Yew  Hep
Dol & 8 i ¥
o sy o sers
Tyras L TR T T (=]
St ot
ekl b, Gt 2 I
M et Infirrwln
sl et G o v [ -1 B: H- B
#hane and e System
[ Univorisd Theen-phadn Swine T Uil Those-ptsn dwing S Trrne-phecse 4w (15 siement)
e Vol ge e Currend
T 0; Wi il g Ipnal{ 1507, SR BN A AC 1 i Wil Viliagen {1500, 00T, BOON)SA AC
Ackmonel Fgd mned Culpul Funcion
Gt 4 Blgind et @2 1 Oagitad inpad, 1 Puben Sutpas
01 a1 Ao Culed i 1 Dagted g, 1 Awilog Cutpd, 1 P Gl
Dorrresw i Pt 1 0 R85 Comrraricalion @ 3 BE4Bs o i, Blbeerrocd i
Dyl Menwaing Furdon [# T @ 31 Domwnrel Wemriarrriont (1 Dormand Alarm Outgul)
o Tupply S TS Ak 10 IO, 00 DTk 1)
Frans Indicason Formag QR RS aed T indications @ & A, 0 e © inccations.
i Parriors
Phans ard v System
@ Srge-phate Towire @ Single-phase i  Those-prase Swine
Il Volagedngd Current
DA AL I TN A AC @ A AT Gard ngut Paranstans
ety
2. Click OK.

The sending starts. When the sending of the input parameters is complete correctly,

a message appears to indicate it.

Send setting

T E Send input parameters ko connecting machine?
.

o]

Cancel |

3. Click OK.

Communication information

Y

X

Conneckion errar,
please check communication setting!
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Sending the Parameter Setting

Send the parameter setting data to the device.

1. Set the parameter setting, and then click Send Parameter Setting.

A confirmation dialog box for sending the setting opens. (The figure below shows
the Example Screen of the PR300.)

"Lt Pownrcart PC paramatar satting tonl - [HmwFila]

Ple Commurkcaton Sstbrg Ve el

Dol & & %< Y% ¥ )

e, i
Wt st [
ot s [ 1o
[Py — B «
Mosurs Bom fr Pulse Onkind [ scove Erergy D]
Pulss Ut T s
OH Pukse it e -
R e B
Lower Lt of Scateg ET -
U Lt it Sy oo JB
Demand PoweriCument @ sctivefower D Cament
S b . -
Demand Assrm Mazk Tme -
hernand Adrrh Pt m A
Damand Asn Relaana Function e Ressans B Ml Resats
Wamator Gl Mode @ - o oFF
inkig Tima dor Inccator $ut Hode I
Sord Porsneter Seten |
l.lnr-h-
2. Click OK.

The sending starts. When the sending of the parameter setting is complete
correctly, a message appears to indicate it.

Send setting

' E Send parameter setting ko connecting machine?
L

[o]4 | Cancel |

3. Click OK.

Send setting

\l.) Success to change setting

IM 77C01Y01-01E  1st Edition : May.26,2006-00
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Sending the Display Pattern Setting (For the PR300 Only)
Send the display pattern setting data to the device.

1. Set the display pattern, and then click Send Display Pattern Setting
A confirmation dialog box for sending the setting opens.

e Pwmreart PC parameter satting ool - [HmsEile]

Fls  Commurkcation Ssthing Wew  Help

OFd & & sy ¥

Riiachr

2. Click OK.

The sending starts. When the sending of the display pattern setting is complete
correctly, a message appears to indicate it.

Send setting

' : Send display pattern setting ko connecting machine?
L3

oK I Cancel

3. Click OK.

Send setting

% 1 J Success ko change setting

IM 77C01Y01-01E  1st Edition : May.26,2006-00
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Sending Collectively (Input Parameters, Parameter Setting, and Display
Pattern Setting)
1. From the Communication menu, choose Send Setting. You can also click the

Send Setting icon on the toolbar. A confirmation dialog box for sending the setting
opens.

E= Powercert PC parameter setting tool - [NewFile]

File Communication Setting Wi Help
NeW 8 We) ?
N

2. Click OK.

The sending starts. When the sending of the input parameters, parameter setting,
and display pattern setting is complete correctly, a message appears to indicate it.

Send setting

Confirm to send the Following?
! 5 Input Parameters
Parameter Setting
Display Pattern Setting

Ok | Cancel

3. Click OK.

Send setting

1 ) Success to change setting

IM 77C01Y01-01E  1st Edition : May.26,2006-00



<2. Configuring the Power and Energy Meter> 2-11

2.5 Saving the Setup Data

Saving to a File by Specifying a Name

The setup data (input parameters, parameter setting, and display pattern setting) can be
saved to a file by specifying the file name.

Note
The extensions to setup data files are .P3D for the PR300 and .U1D for the UPM100/UPM101.

1. From the File menu, choose Save As.
The Save As dialog box opens.

Save As 1"21
Savein | L3 Dota -] + @ = E@B-

= PR AMSETO.PAD

Filie name; I
Save a5 hpe |I"F:.il.l el e P30 LI Cancal |

2. Specify the save destination, enter the file name, and click Save.
The setup data is saved.

Saving (Overwriting) to the File

From the File menu, choose Save. You can also click the Save icon on the toolbar. The
setup data is saved (overwritten).

E= Powercert PC parameter, setting tool - [NewFile]

File Commpunication  Setting  View Help

DkH)S & %% |7
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2.6 Printing the Setup Data

Previewing the Print

You can preview the print layout before actually printing the data.
From the File menu, choose Print Preview. The print preview window opens.

& Powercert PO parsmeter selting foal - [Hewl e

[T TR iy 1)

By LET]
e -

Bariad me LTI

LT LT

dEpat PlassaLars
Fhiis wad Wi gsies

Figure2.10 Print Preview Screen (Example Screen of the PR300)

Printing

1. From the File menu, choose Print. You can also click the Print icon on the toolbar.
The Print dialog box opens.

£z Powercert PC parameter, setting tool - [NewFile]

File Communication Setting Wiew Help

DEeEE E %1 %

2. Click OK to execute printing.

Print

Pririter

Mame: Canon LEP-430 Froperties...

Status: Feady
Type: Canon LEP-430

Where:  LPT1:

Comment: [ Print to file
Frint range Copies

e Al Mumber of copies: m
" Pages from:’1— to:l— ﬂ Iﬁ 7

~

oK | Cancel
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3. Receiving or Setting the Energy Value

Before carrying out the following procedure, check to see that the communication mode
and parameters are set correctly. For details, see Section 2.2, “Setting the
Communication Mode for Connecting to the Power and Energy Meter.”

1. From the Communication menu, choose Integral Energy. You can also click the

Integral Energy icon on the toolbar. A confirmation dialog box for receiving setting
opens.

£z Powercert PG parameter setting tool - [NewFile]

File Communicaktion Setting Wiew Help

DM S & % yr)?

2. Click OK.

The reception starts. When the reception of the energy value is complete, a
message appears to indicate it.

Receive setting

T 'f Receive energy from connecting machine?
L

(0] 4 | Cancel |

3. Click OK.
The received setup data is displayed.

X
0K 1

Energy

Sending the energy value:

1. Click the item in the Send
Subject.

2. Enter the energy value when
sending the energy value.

3. Click Send.
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Figure3.1 Energy Value Reset Screen

Note

Use the energy value setting when the energy value needs to be set to the device in advance.
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